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Introduction

Learn-by-Doing: Microsoft Office Specialist Excel 2019
As the name implies, the Learn-by-Doing Series gets students learning Microsoft Office 
2019 by using its applications to communicate and share information in the real world 
of work and life. This book uses step-by-step instructions and illustrative screenshots 
to introduce and reinforce the skills assessed on the Microsoft Office Specialist Excel 
Associate 2019 Certification Exam. 

Designed for today’s interactive, visual learner, this text consists of graphical hands-on 
lessons that get students instantly engaged in applying Microsoft Excel 2019 skills. 
Students will learn how to format data, work with numbers and formulas, and create 
charts and graphs as they acquire the skills needed for school and workplace readiness. 

Microsoft Office Specialist (MOS) Certification
Microsoft Office Specialist (MOS) is an industry-leading certification designed to 
assess mastery of Microsoft Office applications. Candidates are evaluated on their 
ability to apply their knowledge of important Microsoft Office features in a project-
based environment. Certified Microsoft Office Specialists demonstrate internationally-
recognized skills that can be leveraged for future success in both the classroom and 
the workplace. To support students seeking MOS certification, this text provides 
detailed instruction in all of the skills assessed on the MOS Excel Associate 2019 
Certification Exam.

Benefits of Using This Textbook
Learn-by-Doing: Microsoft Office Specialist Excel 2019 is designed to be used by 
students enrolled in a computer applications course that includes spreadsheets in its  
curriculum, and by learners looking to expand their knowledge of Microsoft Excel 2019 
for MOS certification. Students should have a basic familiarity with working on a 
computer. Microsoft Excel skills and features are presented in order, ranging from basic 
to intermediate. The lessons in this book reinforce and build upon knowledge as it is 
acquired; therefore, lessons should be completed in the order presented.

Throughout these lessons, you will also gain hands-on experience with all the skills 
needed to pass the MOS Excel Associate 2019 Certification Exam. MOS certification 
can help boost confidence in your ability to use the key features of Excel 2019 you may 
encounter in the workplace and beyond. MOS certification can also be a valuable asset 
when applying for jobs, helping you demonstrate experience and proficiency in essential 
workplace productivity principles, including communication and collaboration.

Introduction
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Table:
Use this icon to create a table to organize and 
analyze related data.

Remove Duplicates:
Use this icon to remove duplicate records from 
a table.

Insert Columns/Rows:
Select Insert from the shortcut menu, then use one of these 
options to add a row or column to a table.

Last Column:
Use this table style option to emphasize the last column in 
the table.

Table Styles:
Use this drop-down menu to apply a table style to add 
formatting to your table.

Total Row:
Use this table style option to add a 
total row to a table.

Lesson 5.1

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery lessons for this part.

Skills
 � Create Excel tables from 
cell ranges

�� Remove duplicate 
records from tables

 � Add table rows and 
columns

 � Configure table style 
options

 � Insert and configure 
total rows

 � Apply table styles

 � Sort data

Part 5: Working with Shapes and Elements 

Dream Car
Working with Tables

Lesson Overview
At first glance, your Excel worksheet resembles a table in the sense that it 
has columns and rows. However, defining a range as a table boosts your 
ability to manipulate data since the table offers powerful tools, such as 
sorting and filtering. Converting a range of cells to a table also alters the 
row and column design. Rows are shaded with colors that can be changed 
quickly by simply choosing another style. 

In this lesson, you will create a new worksheet containing a list of dream cars and 
their prices. You will then learn to insert and format a table in your worksheet.

160 Learn-by-Doing: Microsoft Office Specialist Excel 2019

5.

Working with Tables Lesson 5.1

Instructions
1. Using Excel 2019, create a new Blank workbook.

2. Save the file as 5.1 Dream Car in your My Excel Projects folder on your hard 
drive or network drive.

3. Key the data as shown in Figure 5.1 A.

  Note: Unless otherwise noted, resize the column widths to fit cell contents.

4. Make the following formatting changes:

a. Insert two rows above row 1.

b. Key the title [Dream Cars] in cell A1.

c. Bold cell A1, change the font size to 16, and the font color to Orange, 
Accent 2, Darker 50%.

5. From the Insert tab, Tables group, do the following:

a. Select cells A3 through B15.

b. Click the Table icon.

c. In the Create Table dialog box, make sure the My table has headers box  
is checked.

  Note: The Create Table dialog box should show the selected cells.

d. Click OK.

6. To delete duplicate records, do the following:

a. From the Table Tools, Table Design tab, Tools group, click Remove 
Duplicates (as shown below):

b. In the Remove Duplicates dialog box, click Unselect All, then select Car 
Name in the Columns list.

c. Click OK to remove the duplicate record, then click OK again.

7. To insert a new column, right-click any cell in column A in the table and select 
Insert, Table Columns to the Left.

8. To insert a new row, right-click in cell A10 and select Insert, Table Rows Above.

5c.

5d.

6c.

8.

7.

6b.

161Part 5: Working with Shapes and Elements

Lesson Overview
Explains the skills and 
concepts that will be 

learned in the lesson and 
provides context for their 

use in a spreadsheet.

Tools & Terms
Illustrates the icons and 

menu descriptions used to 
complete the lesson. 

Skills
Lists the new skills introduced in the lesson. Skills assessed in 
the MOS Excel 2019 Certification Exam are identified with a red 
bullet. To provide comprehensive instruction, foundational and 
supporting skills are also identified.

Instructions & Screenshots
Instructions that are illustrated with corresponding drop-down menus and dialog 
boxes are indicated by a red  #   icon. Match each instruction with its corresponding 
screenshot as you complete the step.

 �Note: Once a new skill has been presented, visual step-by-step instructions for that 
skill are no longer provided in subsequent lessons.

 �Note: Office 365 is a suite of web-based applications; updates and changes happen 
regularly. At the time of going to press with this textbook, every attempt was made 
to reflect accurate screenshots and include tasks and skills that can be accomplished, 
with minor modifications, despite any updates that may occur.

Lesson Title

Introduction

Understanding the Format of This Book
This book is divided into seven parts, each containing individual lessons pertaining to 
the principal tools in each tab of Microsoft Excel 2019. Lessons in this book have been 
organized into an easy-to-read, self-guided, visual format where you encounter and 
practice new skills and learn by doing. Some lessons require access to source files to 
complete the instructions. If you do not have access to the eText of this book, lesson 
resources will be provided by your instructor.

Review the following features and components to become familiar with the structure 
of the lessons in Learn-by-Doing: Microsoft Office Specialist Excel 2019.

iv Learn-by-Doing: Microsoft Office Specialist Excel 2019For Evaluation Purposes Only



Lesson 5.1 Working with Tables

9. In cell B10, key the text [Ferrari F60 America].

10. In cell C10, key the text [2500000].

11. In cell A3, key the heading [Rank].

12. Use AutoFill to rank the cars from 1 to 12.

13. From the Price drop-down menu in column C, select Sort Smallest to Largest.

14. From the Table Tools, Table Design tab, Table Style Options group, check the 
boxes Header Row, Total Row, Banded Rows, Last Column, and Filter Button.

15. From the Table Tools, Table Design tab, Table Styles group, More drop-down 
menu (shown below), do the following:

a. From the Dark section, choose Brown, Table Style Dark 3 (as shown below):

16. Merge and center cell A1 across columns A through C.

17. Format column C as Accounting with no decimal places.

18. Resize the column widths to fit cell contents.

19. Proofread your work for accuracy, then resave the file.

20. Print preview. Your worksheet should look similar to Figure 5.1 B.

21. Print or share the worksheet if required by your instructor.

13.

14.

162 Learn-by-Doing: Microsoft Office Specialist Excel 2019

Rank Car Name Price
9 Koenigsegg One:1 2,000,000$          

10 Koenigsegg Regera 2,000,000$          
7 Ferrari F60 America 2,500,000$          
8 Bugatti Chiron 2,500,000$          
6 Pagani Huayra BC 2,600,000$          

12 LaFerrari FXX K 2,700,000$          
5 Ferrari Pininfarina Sergio 3,000,000$          
3 W Motors Lykan Hypersport 3,400,000$          
4 Limited Edition Bugatti Veyron 3,400,000$          
2 Lamborghini Veneno 4,500,000$          
1 Koenigsegg CCXR Trevita 4,800,000$          

11 Mercedes‐Benz Maybach Exelero 8,000,000$          
Total 41,400,000$        

Dream Cars

1
2
3
4
5
6
7
8
9
10
11
12
13

A B
Car Name Price
Koenigsegg CCXR Trevita 4800000
Lamborghini Veneno 4500000
W Motors Lykan Hypersport 3400000
Limited Edition Bugatti Veyron 3400000
Ferrari Pininfarina Sergio 3000000
Pagani Huayra BC 2600000
Bugatti Chiron 2500000
Koenigsegg One:1 2000000
Ferrari Pininfarina Sergio 3000000
Koenigsegg Regera 2000000
Mercedes‐Benz Maybach Exelero 8000000
LaFerrari FXX K 2700000

Figure 5.1 A

Figure 5.1 B

Lesson 5.1Working with Tables
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Introduction

Figure
Provides the content to 
be used in the lesson. 
Figures can also be used 
as visual guidance to assist 
in producing the finished 
formatted spreadsheet.

Ribbon
The primary Microsoft Excel 2019 tab being used in the lesson is displayed 
at the top of the Instructions page. Red  #   icons illustrate the group being 
used to complete a particular skill.
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Part 2 
Skills Mastery Quiz 2.2 

Skills 
• Apply cell formats 
• Adjust row height and column width 
• Fill cells by using Flash Fill 
• Modify cell alignment and indentation 

• Wrap text within cells 
• Merge cells 
• Search for data within a workbook 
• Replace data 

Instructions 
1. Using Microsoft Excel 2019, open the file named Skills Mastery 2.2 SOURCE.   

2. Save the workbook as Skills Mastery 2.2 Your Name to your local or network hard drive.  

3. Replace all occurrences of the text [Country] with the text [Rural]. 

4. Use Flash Fill to fill column B with the school’s short name. 

5. Italicize and underline cell A1. 

6. Change the font of the entire worksheet to Arial and the font size to 13. 

7. Change the height of rows 1 through 3 to 75. 

8. Wrap the text in cells A2 and E3. 

9. Merge and center cell A1 across columns A through G. 

10. Indent cells A4 through A18. 

11. Change the fill color of cells B1 and B2 to Green, Accent 6, Lighter 60%. 

12. Apply a bottom double border to cells B3 through G3. 

13. Proofread your spreadsheet for accuracy and format, then resave the file.  

14. Print or share the document if required by your instructor. 

Skills Mastery
Upon completion of all the lessons in each part, your 
instructor may require you to complete a series of 
Skills Mastery Quizzes. These quizzes offer you the 
opportunity to demonstrate mastery of new skills and 
assess your knowledge of the essential features of 
Microsoft Excel 2019.

Skills Mastery lessons for each part are located with the 
Instructor Resources.
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 1: Worksheet Basics

1.1 Put It in a Safe 
Place

Exploring Places to Save 
Work

 Use File Manager  Create a folder  Log in to 
OneDrive  Sync to OneDrive

.5

1.2 Getting Started Navigating Excel  Create a workbook  Change magnification  
by using zoom tools  Identify tabs and groups 
 Understand Backstage View  Close Excel

.75

1.3 Top Selling Albums Creating Your First Workbook  Create a workbook  Save a workbook to 
a local hard drive or network drive  Close a 
workbook

.75

1.4 Top Selling Albums 
2

Retrieving and Printing a 
Worksheet

 Open an existing workbook from your hard 
drive or network drive  Revise an existing 
worksheet  Use Save As  Save workbooks in 
alternative file formats  Preview a worksheet  
 Print all or part of a workbook

.75

1.5 When I Grow Up Emailing a Worksheet  Email a worksheet as an attachment  Email 
from within Excel

.75

1.6 Chicago Cubs 
Roster

Working with Columns, 
Rows, and Cells

 Adjust row height and column width  Insert 
and delete multiple columns or rows  Insert 
and delete cells  Freeze worksheet rows and 
columns

.75

1.7 Cost of Living Editing Basics  Cut, copy, and paste data  Use Undo .5

1.8 Top Instagram 
Accounts

Proofing Your Worksheet  Use Spellcheck  Use Thesaurus  Paste data 
by using special paste options

.75

1.9 Tasty Customizing the Quick 
Access Toolbar

 Use Redo  Customize the Quick Access 
toolbar

.5

1.10 When I Grow Up 2 Getting Help and 
Information

 Use Search  Apply number formats  Wrap 
text within cells  Use Smart Lookup  Inspect 
workbooks for issues - hidden properties  
 Modify basic workbook properties

.5

Part 1 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 2: Formatting Data

2.1 Weekly Meal Plan Formatting Data  Apply cell formats  Adjust row height and 
column width

.75

2.2 Daily Calendar Enhancing Data within a 
Workbook

 Apply cell formats .75

2.3 Contact List Applying Basic Data and 
Cell Alignment

 Modify cell alignment  Fill cells by using Flash 
Fill

.75

2.4 Cinnamon Roll 
Recipe

Applying Enhanced 
Alignment Tools

 Modify cell alignment, orientation, and 
indentation  Wrap text within cells  Merge 
cells

.75

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

2.5 Top Broadway 
Shows

Using the Format Cells 
Dialog Box

 Apply cell formats from the Format Cells 
dialog box  Modify cell alignment and 
orientation  Search for data within a workbook 
 Replace data

.75

2.6 Fitness Class 
Schedule

Applying Conditional 
Formatting

 Apply built-in conditional formatting .75

Part 2 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 3: Page Layout Options

3.1 Cinnamon Roll 
Recipe 2

Adjusting Page Setup  Modify page setup  Set a print area .5

3.2 State Facts Scaling a Workbook  Set page scaling .75

3.3 Skeletal System Controlling What Excel Prints  Modify page setup .5

3.4 Thrill Seekers Printing Multiple Pages  Modify page setup  Display repeating row 
titles on multipage worksheets  Display and 
modify workbook content in different views

.75

3.5 College Football Giving a Worksheet a Unique 
Style

 Set page scaling  Change workbook themes .5

Part 3 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 4: Working with Numbers and Formulas

4.1 Bestsellers Formatting Numbers  Fill cells by using Auto Fill  Clear cell 
formatting  Apply cell styles  Apply number 
formats  Display repeating column titles on 
multipage worksheets

.75

4.2 Bestsellers 2 Sorting Text  Sort data .5

4.3 Smartphone Apps Sorting Numbers  Remove duplicate records  Sort data by 
multiple columns

.5

4.4 Paycheck  
Calculator

Using Excel as a Calculator  Apply number formats  Use basic formulas: 
addition, subtraction, multiplication, and 
division  Insert relative references

.5

4.5 Food Drive Formulas Made Easy  Fill cells by using Auto Fill  Paste data by 
using special paste options

.75

4.6 Student Grades Commonly Used Formulas  Use AutoSum  Perform calculations by using 
AVERAGE(), MAX(), MIN(), and SUM() functions

.75

4.7 Semester Grades Auditing Formulas  Use multi-math formulas  Display formulas .75

4.8 Add/Drop Period Formatting Date and Time  Apply number formats .75

4.9 Magazine Sales Working with Named 
Ranges

 Insert relative, absolute, and mixed references 
 Define a named range  Navigate to named 
cells or ranges  Reference named ranges in 
formulas

1

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

4.10 Student  
Information

Formatting Text with 
Functions

 Format text by using RIGHT(), LEFT(), and 
MID() functions  Format text by using UPPER() 
and LOWER() functions  Format text by using 
the CONCAT() function  Format text by using 
the PROPER() function

.75

4.11 Hobby Survey Summarizing and Tallying 
Data

 Perform conditional operations using the IF() 
function  Count cells by using the COUNT(), 
COUNTA(), and COUNTBLANK() functions  
 Perform logical operations using the SUMIF(), 
AVERAGEIF(), and COUNTIF() functions  Hide or 
unhide columns and rows

.75

4.12 Lunch Orders Grouping and Outlining 
Data

 Insert subtotals  Outline data  Group and 
ungroup data

.75

4.13 Hobby Survey 2 Using Worksheet Views  Hide or unhide columns and rows  Change 
window views  Navigate to named cells  
 Insert hyperlinks

.75

4.14 Soccer Referee 
Info

Combining Text with 
Functions

 Format text by using the LEN() function  
 Format text by using the TEXTJOIN() function  
 Use the SEARCH() function  Combine 
multiple functions

1

Part 4 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 5: Working with Shapes and Elements

5.1 Dream Car Working with Tables  Create Excel tables from cell ranges  Remove 
duplicate records from tables  Add table rows 
and columns  Configure table style options  
 Insert and configure total rows  Apply table 
styles  Sort data

.5

5.2 Contact List 2 Working with Illustrations  Filter records  Insert images and shapes  
 Inspect workbooks for issues - accessibility  
 Add alternative text to objects for accessibility

.5

5.3 Business Schools Working with Hyperlinks  Insert and remove hyperlinks .5

5.4 Food Drive 2 Using Multiple Worksheets  Add a worksheet to an existing workbook  
 Rename a worksheet  Change worksheet 
order  Change worksheet tab color  Copy and 
move a worksheet  Hide or unhide columns 
and rows  Hide or unhide worksheets  
 Configure print settings

.5

5.5 Sales Invoice Adding Text Elements  Customize headers and footers  Insert 
a signature line  Insert text boxes  Insert 
WordArt  Apply text effects

.75

5.6 Daily Planner Using Symbols and Icons  Insert icons  Format cells by using Format 
Painter  Use the TODAY() function  Insert 
symbols

.75

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

5.7 Personal Budget Importing a Text File  Import data from .txt files  Sort data by 
multiple columns  Change sort order  Convert 
tables to cell ranges

.5

5.8 Personal Budget 2 Working with PivotTables  Create PivotTables  Refresh PivotTables .5

5.9 Food Drive 3 Using Information Across 
Worksheets and Workbooks

 Copy and move a worksheet between 
workbooks  Change window views  Insert 
references across worksheets  Unmerge cells

.75

5.10 Clothing Store 
Inventory

Working with Table 
References

 Import data from .csv files  Insert and delete 
multiple columns or rows  Insert and delete 
cells  Navigate to named workbook elements 
 Name a table  Reference named tables in 
formulas

.75

5.11 Ice Cream Shop 
Revenue

Modifying Tables  Remove conditional formatting  Add or 
remove table rows and columns  Insert and 
configure total rows

.75

Part 5 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 6: Working with Charts and Graphs

6.1 Spring Colors Creating a Pie Chart & a 
Sunburst Chart

 Create charts - pie and sunburst  Add and 
modify chart elements  Create chart sheets  
 Inspect workbooks for issues - compatability

.75

6.2 Most Watched 
Videos

Creating a Column Chart & 
a Treemap Chart

 Create charts - column and treemap  Apply 
chart layouts  Apply chart styles  Add and 
modify chart elements  Configure print 
settings

.75

6.3 Olympic Results Creating a Line Chart & a 
Map Chart

 Create charts - line and map .75

6.4 Superhero Stats Creating a Bar Chart  Create charts - bar  Resize charts .75

6.5 Tech Device  
Ownership

Creating a Sparkline Chart  Insert Sparklines  Analyze data by using 
Quick Analysis

.5

6.6 Student  
Enrollment

Forecasting Data  Create a forecast worksheet .5

6.7 Superhero Stats 2 Updating Existing Charts  Add data series to charts  Change the chart 
type  Switch between rows and columns in 
source data  Add alternative text to charts for 
accessibility

.75

6.8 My Check Register Using a Template  Create a workbook from a template .5

Part 6 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 7: Sharing and Working Collaboratively

7.1 Roommate  
Expense Tracking

Communicating within 
Spreadsheets

 Add and delete comments  Review and reply 
to comments  Add and delete notes  Print 
showing comments and notes

.75

7.2 Weekly Spending Sharing Files  Save a spreadsheet to OneDrive  Share a 
spreadsheet  Assign collaboration permission 
 Move OneDrive files

.75

7.3 Household Chores Managing Revisions  Create a new spreadsheet with Excel Online 
 Edit spreadsheets with Excel Online  Review 
version history

.75

7.4 Homework Using Comments While 
Collaborating

 Collaborate simultaneously  Add and 
manage comments in Excel Online

.75

7.5 Ticket Sales Working with AutoSave  Using AutoSave  Using Save a Copy  Using 
Version History

.75

Part 7 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Total Completion Time: 39 hrs.

Curriculum Guide
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Part 1
Worksheet Basics

1.1	 Put It in a Safe Place 
Exploring Places to Save Work

1.2	 Getting Started
Navigating Excel

1.3	 Top Selling Albums
Creating Your First Workbook

1.4	 Top Selling Albums 2
Retrieving and Printing a Worksheet

1.5	 When I Grow Up
Emailing a Worksheet

1.6	 Chicago Cubs Roster
Working with Columns, Rows, and Cells

1.7	 Cost of Living
Editing Basics

1.8	 Top Instagram Accounts
Proofing Your Worksheet

1.9	 Tasty
Customizing the Quick Access Toolbar

1.10	 When I Grow Up 2
Getting Help and Information

Part 1 Skills Mastery
Skills Mastery Quizzes are located with the Instructor Resources.
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File Manager: 
The interface you use to view your 
computer’s folder structure is called a 
file manager. Windows 10 utilizes File 
Explorer. When launched, it allows 

the user to see folders and files located on the computer’s 
hard drive, network drive, and any connected removable 
drives. Some cloud storage drives may also be visible if your 
computer has been configured to connect automatically to 
a cloud storage account.

Network Drive: 
Many organizations such as schools 
and companies give users access to 
a shared computer drive called a 
network drive. This large hard drive 

contains files from all users in the organization and would 
require a login provided by the network manager. Saving 
work to a network drive allows you to retrieve that work 
once you have logged into the network.

Local Drive: 
A computer’s local drive is the hard 
drive located inside your computer. 
It is the place that programs are 
typically installed and where files 

can be saved. If files are saved to a computer’s local drive, 
they can only be opened from that particular computer.

Removable Drive: 
There are many types of removable 
storage devices which a computer 
can accept. Examples include 
external hard drives, USB drives 

(also referred to as thumb drives or flash drives), and 
memory cards. Often these drives are used to back up files, 
but they are also used to transport your work from one 
computer to another.

Lesson 1.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Use File Manager

�� Create a folder

�� Log in to OneDrive

�� Sync to OneDrive

Part 1: Worksheet Basics 

Put It in a Safe Place 
Exploring Places to Save Work

Lesson Overview
When using a computer, saving an electronic file is much like saving hard 
copies of files—they need to be put somewhere. Imagine your computer 
is a file cabinet with many drawers. In each drawer there are folders and 
in each folder there are subfolders and files. Just as you would never just 
toss a report in a random drawer, you would never save work without 
first deciding which drawer, or in this case which drive, to save it to. Once 
the drive has been chosen, you can be even more intentional about your 
organization and save the file to a particular folder within that drive.

In this lesson, you will identify and explore the places that work can be saved. 
You will not be required to save any work. 
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Tools & Terms (cont.)

Office 365: 
A subscription to Office 
365 provides users with 

periodic updates to Microsoft Office’s desktop and online 
applications. While users of Excel 2019 will be able to 
create, format, save, and share spreadsheets, using Office 
365 means that Excel will be automatically updated with 
any updates that Microsoft makes available. Office 365 
subscribers also have an added feature allowing them to 
AutoSave documents to the user’s OneDrive account. 

Since Office 365 is regularly updated, what appears on your 
screen may differ from the instructions and screenshots 
presented in this text. However, with minor modifications, 
most lessons can be completed successfully.

AutoSave: 
Many online applications, 
such as Excel Online, provide 
automatic saving of your 

files to your cloud storage. As you work, the application 
will periodically save your changes without you having to 
initiate the save. Office 365 subscribers can take advantage 
of AutoSave to have spreadsheets that are saved to 
OneDrive automatically updated as they work. Since files 
are overwritten periodically, you may want to preserve an 
original copy of a file before making changes. Utilize Save 
a Copy before making changes to a spreadsheet or use 
Version History to bring back previous versions of the file.

Cloud Drive: 
Cloud storage allows a user to 
work with files that are physically 
unattached to your computer. 
Files are saved to a place that 
is accessed via the web, which 
makes working from various 

places easy and convenient. As long as you have an 
Internet connection, you have access to your cloud drive. 
Examples of cloud storage include OneDrive, Google Drive, 
and Dropbox. Many cloud storage platforms provide an 
application to work on the file. For example, when opening 
an Excel spreadsheet from OneDrive, the user has the 
option to edit the spreadsheet directly in their web browser 
without having to open their Microsoft Excel 2019 program. 

Syncing: 
It is possible to sync your OneDrive 
account to your computer. Syncing 
provides access to the folders and 
files on your OneDrive cloud storage 
account when you are working offline. 
It also allows your OneDrive cloud 
storage folders to appear in your 

computer’s file management interface. Otherwise, you 
must open OneDrive.com from your computer’s web 
browser to upload and download saved documents.

Lesson 1.1Exploring Places to Save Work

Important Note: In this lesson, you will set up folders on your hard drive or network drive and your OneDrive. This 
process will vary depending on your workstation settings.

1.	 Create a folder on your hard drive or network drive and name it My Excel Projects.

2.	 Unless you are already set up to connect with your OneDrive account automatically, log in to your OneDrive 
account from OneDrive.com.

3.	 Create a new folder on your OneDrive and name it My Online Excel Projects.

4.	 Sync your OneDrive account to your computer.

 Note: You will be instructed in each lesson on what to name the lesson file and on which drive to save it.

Instructions
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Lesson 1.2 

Launching Excel & Working with Files

Lesson Overview
Microsoft Excel 2019 is a powerful program that allows you to enter data, 
write and calculate formulas, analyze results, and display data in multiple 
formats. In Excel, you enter data into what is called a worksheet. Whether 
you are keeping a budget, creating an invoice, or formatting a financial 
report, Excel makes it easy to work with different kinds of data. 

In this lesson, you will become familiar with the Excel application interface. 

Part 1: Worksheet Basics 

Getting Started
Navigating Excel

Skills
�� Create a workbook

�� Change magnification 
by using zoom tools

�� Identify tabs and groups

�� Understand Backstage 
View

�� Close Excel

Start Screen
When Microsoft Excel opens, the first thing you see is the 
Start Screen. From the Start Screen you can open existing 
workbooks from a list of recent, pinned, or shared files, or 
create a new file using a blank workbook or a spreadsheet 
template. You also can look for more templates online using 
the Start Screen search tool or open a tutorial file to learn 
more about specific tools. 

Backstage View
Located by clicking the File tab, the Backstage View is the central 
place for managing your workbooks. Actions such as saving, 
printing, sharing, exporting, or opening a previously saved file can 
also be done here. Different options appear depending on your 
selection. For example, when you select Open, your computer’s 
file folders and cloud folders appear on screen. 

Clicking on the back arrow, or the Esc Key, 
returns you to the open file.

The Excel program icon launches Microsoft Excel 2019 from the Windows Start Menu or Start Screen. 
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Group Icon Dialog Box Launcher 

Drop-down Menu

H Sheet Tab Control
I View Controls

WorksheetG

B DCQuick Access Toolbar Ribbon Program Window Controls

EShare Control

FComments

A AutoSave

Lesson 1.2Navigating Excel

Application Window
The Excel application window displays the working area of your worksheet and 
provides access to the tools needed to enter, edit, and format data.

Ribbon Parts
The Excel ribbon user interface keeps related tools organized and easily accessible.

Tools are organized within tabs, which contain groups of related features and commands. 
Graphical icons or menu items control the editing and formatting of an Excel worksheet. 
Some tools or groups have additional options accessible from a drop-down menu or 
dialog box launcher.

Application Window Key 

A 	 AutoSave
	 Allows Office 365 users to 

automatically save their worksheet 
to OneDrive or SharePoint every 
few seconds

B 	 Quick Access Toolbar
	 Commonly used commands at the 

top of the application window, which 
can be customized to stay visible

C 	 Ribbon
	 Groups of related tools organized 

within a set of tabs, which can be 
collapsed or expanded

D 	 Program Window Controls
	 Allow you to move, resize, and 

close the application window, and 
customize  ribbon display options

E 	 Share Control
	 Allows you to share a workbook 

with another user and see who a 
workbook is currently shared with

F 	 Comments
	 Allow you to review and respond to 

comments in a document

G 	 Worksheet
	 A single spreadsheet made up of 

cells organized by rows and columns

H 	 Sheet Tab Control
	 Allows you to add and navigate 

through multiple worksheets

I 	 View Controls
	 Adjust zooming in and out of a 

worksheet, as well as select page 
view options

Ribbon Parts Key 

A 	 Tab
	 Displays the ribbon’s name and 

contains related groups of different 
tools and commands to perform 
the most common tasks

B 	 Group
	 Contains related features and tools 

organized within a ribbon’s tab

C 	 Drop-down Menu
	 Allows you to choose a command 

from a list of options

D 	 Icon
	 An interactive tool that activates its 

feature when clicked

E 	 Dialog Box Launcher
	 Opens a window with information 

and options about a particular tool 
or group
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Page View Options

Lesson 1.2 Navigating Excel

View Controls
The controls at the bottom right of the document adjust zoom and present 
different page view options.

Worksheet
The Excel worksheet is where data is entered, organized, and calculated. 
Worksheets are divided into columns and rows. The intersection point of a 
column and row is a cell. Data is entered and stored in individual cells. 

Status Bar
The Status Bar can be easily customized to give you information about the 
workbook you are working on by right-clicking the bar. 

B C D

A Cell Mode

Average Count Sum

Worksheet Key

A 	 Name Box
	 Displays the name or location of the 

active cell

B 	 Formula Bar
	 Where data and formulas are 

entered and edited, which then 
appears in the active cell

C 	 Column
	 Vertical cells that are labeled by 

letters

D 	 Row
	 Horizontal cells that are labeled by 

numbers

E 	 Cell
	 The intersection of a row and 

column, which is identified by a 
letter and number

F 	 Sheet Name Tab
	 Sheets can be added or deleted, 

renamed, and reordered

View Controls Key

A 	 Page View Options
	 Allow you to select page view 

options that include Normal 
(default), Page Layout, and Page 
Break Preview

B 	 Zoom Adjustment
	 Adjusts zooming in and out of a 

worksheet

Status Bar Key

A 	 Cell Mode 
	 The current cell editing mode will 

display

B 	 Average 
	 The average of selected cells will 

display

C 	 Count 
	 The number of selected cells will 

display

D 	 Sum 
	 The sum of numerical values in 

selected cells will display
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9.

3.

8.

10.

Lesson 1.2Navigating Excel

Instructions
1.	 Locate the Excel program icon and launch Excel 2019.  

2.	 From the Start screen, Home section, select Blank workbook.

3.	 In the Name Box, notice the cell address A1. This is the active cell.

4.	 Key your first name in cell A1 and hit Enter. Notice that you are now in cell A2.

5.	 Go to the Backstage View of Excel by clicking on the File tab. Notice the saving 
and printing options available.

6.	 Click on the Arrow (or hit the Esc key) to return to your open worksheet.

7.	 Practice getting to know the Ribbons and their parts by clicking some of the 
Tabs such as Insert, Page Layout, Formulas, etc. (as shown below):

8.	 While exploring the various tabs, notice the groups of related features and 
commands, such as the Font and Alignment groups within the Home tab.

9.	 Within some of the groups, notice the diagonal arrow in the bottom right 
corner. This is the Dialog Box Launcher for that group. Click on one to see the 
dialog box it opens. Click the cancel button to close the dialog box.

10.	 Click on a few of the Drop-down Menus and notice the different tool options. 

11.	 Hover your mouse over different positions of the active cell and notice how your 
cursor changes.

12.	 Hover over row labels and column labels and notice how your cursor changes 
to solid filled arrows.

13.	 Hover between row labels and between column labels and notice how your 
cursor changes to a double-headed arrow.

14.	 Use the slider on the View Controls at the bottom right of the document to 
increase and decrease the zoom setting of your page (as shown below): 

15.	 Close Excel by clicking on the X icon in the top right corner  
of the window. 

 Note: Do not save your workbook.
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Increase Indent:
Use this icon to move your content farther 
away from the cell border.    

Wrap Text:
Use this icon to wrap extra-long text into multiple lines so 
you can see all of it. Merge & Center:

Use this icon to combine and center the contents of the 
selected cells in a new larger cell.

Orientation:
Use this icon to rotate your text diagonally 
or vertically.

Decrease Indent:
Use this icon to move your content closer 
to the cell border.

Vertical Cell Alignment: 

Top Align:
Use this icon to align the content at 
the top of the cell.

Middle Align:
Use this icon to center the content 
between the top and bottom of the cell.

Bottom Align:
Use this icon to align the content to 
the bottom of the cell.

Lesson 2.4

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Part 2: Formatting Data 

Cinnamon Roll Recipe
Applying Enhanced Alignment Tools

Lesson Overview
Microsoft Excel 2019 has many enhanced alignment tools to help with the 
look of your spreadsheet. Add visual interest to your work by rotating text 
vertically in a cell. Merging and centering text across multiple cells can help 
bring attention to a worksheet’s title or section heading, while indenting 
text within a range gives your work a uniform look without having to 
manually hit the space bar in each cell.

In this lesson, you will create a new worksheet containing a recipe for cinnamon 
swirl rolls. You will be introduced to enhanced alignment tools to help your 
recipe look professional. 

Skills
�� Modify cell alignment, 
orientation, and 
indentation

�� Wrap text within cells

�� Merge cells
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1.	 Using Excel 2019, create a new Blank workbook.

2.	 Save the file as 2.4 Cinnamon Roll Recipe in your My Excel Projects folder on 
your hard drive or network drive.

3.	 Key the data as shown in Figure 2.4 A.

 Note: Unless otherwise noted, resize the column widths to fit cell contents.

4.	 Make the following formatting changes:

a.	 Change the width of columns B to 45 and C to 30.

b.	 Bold cells B3, C3, and C7.

c.	 Italicize cells B15 through B35 and change the font size to 10.

5.	 From the Home tab, Alignment group, do the following:

a.	 Select cells B3 through C13 and increase the indent one time.

b.	 Select cells B3, C3, and C7 and decrease the indent one time.

c.	 Increase the indent of cells B15 through B35 one time.

d.	 Wrap the Text in cell B37.

e.	 Select cells A1 through C1 and Merge & Center.

f.	 Change the font size of cell A1 to 18 and the font color to Blue.

g.	 Select cells A3 through A13, bold the text, merge and center, then from 
the Orientation drop-down menu, select Vertical Text.

h.	 Select cells A15 through A35, bold the text, merge and  
center, apply Vertical Text orientation, and Middle Align.

i.	 Change the width of column A to 12.

6.	 Apply Blue, Accent 5, Lighter 80% fill color to cells A3 and A15.

7.	 Proofread your work for accuracy, then resave the file.

8.	 Print preview. Your worksheet should look similar to Figure 2.4 B.

9.	 Print or share the worksheet if required by your instructor.

5g.

5.

Applying Enhanced Alignment ToolsLesson 2.4

Instructions
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A B C D
Cinnamon Swirl Rolls

INGREDIENTS Dough Filling
1/2 cup milk 2 tablespoons ground cinnamon 
4 tablespoons unsalted butter  1/3 cup sugar 
2 large eggs
1 tablespoon milk  Frosting
2 tablespoons milk  1 1/4 cups confectioners sugar 
1 package dry active yeast  1/2 teaspoon vanilla extract 
1/2 cup warm water  2 tablespoons milk 
1/3 cup sugar 
1 1/2 teaspoons table salt 
3 1/2 ‐ 3 3/4 cups unbleached all‐purpose flour 

DIRECTIONS 1. For the dough, heat milk and butter until butter melts. Cool.
2. Meanwhile, sprinkle yeast over warm water in bowl.  
3. Beat in sugar and eggs.
4. Add salt, butter and milk mixture, and 2 cups of flour; mix until blended, about 1 minute.
5. Add 1 1/4 cups flour, and knead for 10 minutes until dough is smooth.
6. Turn dough onto work surface.  
7. If dough is sticky, knead in up to 1/2 additional cup flour to form a smooth, soft, elastic dough.
8. Transfer dough to a very lightly oiled large plastic container or bowl.
9. Cover top of container with plastic wrap and let rise until double in size, 2 to 2 1/2 hours.
10. After rise, punch down center of dough once.
11. Turn dough onto unfloured work surface; let dough rest about 10 minutes.
12. Grease a 13‐by‐9‐inch baking pan.
13. For the filling, mix sugar and cinnamon in small bowl.
14. Roll dough with rolling pin into an evenly shaped 12‐by‐16‐inch rectangle.
15. Brush dough with milk and sprinkle with cinnamon‐sugar mixture.
16. Roll, beginning with the long side of the rectangle. 
17. Cut the roll into 12 equal pieces and arrange cut side up in prepared pan.
18. Cover pan with plastic wrap and let rolls rise for 1 hour. 
19. While dough rises, preheat the oven to 350 degrees.
20. Bake for 25 to 30 minutes uncovered. Let rest for 10 minutes before frosting. 
21. For the frosting, mix confectioners sugar, milk, and vanilla.

This delicious recipe serves 6‐8 people, and is sure to be a hit with family and friends alike. 

Figure 2.4 A

Lesson 2.4Applying Enhanced Alignment Tools
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Dough Filling
1/2 cup milk 2 tablespoons ground cinnamon 
4 tablespoons unsalted butter  1/3 cup sugar 
2 large eggs
1 tablespoon milk  Frosting
2 tablespoons milk  1 1/4 cups confectioners sugar 
1 package dry active yeast  1/2 teaspoon vanilla extract 
1/2 cup warm water  2 tablespoons milk 
1/3 cup sugar 
1 1/2 teaspoons table salt 
3 1/2 ‐ 3 3/4 cups unbleached all‐purpose flour 

1. For the dough, heat milk and butter until butter melts. Cool.
2. Meanwhile, sprinkle yeast over warm water in bowl.  
3. Beat in sugar and eggs.
4. Add salt, butter and milk mixture, and 2 cups of flour; mix until blended, about 1 minute.
5. Add 1 1/4 cups flour, and knead for 10 minutes until dough is smooth.
6. Turn dough onto work surface.  
7. If dough is sticky, knead in up to 1/2 additional cup flour to form a smooth, soft, elastic dough.
8. Transfer dough to a very lightly oiled large plastic container or bowl.
9. Cover top of container with plastic wrap and let rise until double in size, 2 to 2 1/2 hours.
10. After rise, punch down center of dough once.
11. Turn dough onto unfloured work surface; let dough rest about 10 minutes.
12. Grease a 13‐by‐9‐inch baking pan.
13. For the filling, mix sugar and cinnamon in small bowl.
14. Roll dough with rolling pin into an evenly shaped 12‐by‐16‐inch rectangle.
15. Brush dough with milk and sprinkle with cinnamon‐sugar mixture.
16. Roll, beginning with the long side of the rectangle. 
17. Cut the roll into 12 equal pieces and arrange cut side up in prepared pan.
18. Cover pan with plastic wrap and let rolls rise for 1 hour. 
19. While dough rises, preheat the oven to 350 degrees.
20. Bake for 25 to 30 minutes uncovered. Let rest for 10 minutes before frosting. 
21. For the frosting, mix confectioners sugar, milk, and vanilla.

This delicious recipe serves 6‐8 people, and is sure to be 
a hit with family and friends alike.
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Cinnamon Swirl Rolls

Figure 2.4 B

Lesson 2.4 Applying Enhanced Alignment Tools
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Lesson 2.6

Tools & Terms
Review the following tool that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of this tool by completing the Skills Mastery Quizzes for this part.

Part 2: Formatting Data 

Fitness Class 
Schedule
Applying Conditional Formatting

Lesson Overview
Working smart means letting Microsoft Excel 2019 do tedious work for 
you. Highlighting trends and patterns in your data can help the reader 
spot what is most important about the information presented and assist in 
decision making. Conditional formatting scans your worksheet for criteria 
and when the condition you specify is met, the cell range is formatted with 
highlighting colors, bars, or icons.

In this lesson, you will create a new worksheet showing the attendance of classes 
at a fitness center. You will then format the worksheet to identify the classes with 
the highest and lowest attendance.

Skills
�� Apply built-in 
conditional formatting

Conditional Formatting: 
Use this drop-down menu to apply bars, colors, and 
icons to highlight trends and patterns in your data.
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5a.
5c.

5d.

5b.

Applying Conditional FormattingLesson 2.6

Instructions
1.	 Using Excel 2019, create a new Blank workbook.

2.	 Save the file as 2.6 Fitness Class Schedule in your My Excel Projects folder on 
your hard drive or network drive.

3.	 Key the data as shown in Figure 2.6 A.

 Note: Unless otherwise noted, resize the column widths to fit cell contents.

4.	 Make the following formatting changes:

a.	 Change the font size of cell A1 to 26.

b.	 Change the font size of cell A2 to 18.

c.	 Change the font size of cell A3 to 12.

d.	 Merge and center cell A1 across columns A through H.

e.	 Merge and center cell A2 across columns A through H.

f.	 Merge and center cell A3 across columns A through H.

g.	 Bold row 5 and change the font size to 12.

h.	 Bold cells A6 through A13 and change the font size to 12.

5.	 From the Home tab, Styles group, do the following:

a.	 Select cells B6 through H13, then from the Conditional Formatting, 
Highlight Cells Rules drop-down menu select Greater Than....

b.	 From the Greater Than dialog box, key [30] in the Format cells that are 
GREATER THAN: field with Green Fill with Dark Green Text, then click OK.

c.	 From the Conditional Formatting, Highlight Cells Rules drop-down menu 
select Less Than....

d.	 From the Less Than dialog box, key [10] in the Format cells that are LESS 
THAN: field with Light Red Fill with Dark Red Text, then click OK.

6.	 Proofread your work for accuracy, then resave the file.

7.	 Print preview. Your worksheet should look similar to Figure 2.6 B.

8.	 Print your worksheet if required by your instructor.
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1
2
3
4
5
6
7
8
9
10
11
12
13

A B C D E F G H
Power Up Fitness
Class Attendance
Week of August 1st

Class Monday Tuesday Wednesday Thursday Friday Saturday Sunday
Power Yoga 12 23 9 33 21 17 31
CrossFit 8 12 33 19 20 5 16
Spinning 22 27 25 8 14 27 37
Circuit Training 16 9 14 31 34 32 18
Raise the Barre 38 21 27 14 19 9 36
Totally Toned 7 28 22 29 18 14 11
Zumba 10 34 29 22 16 13 32
Kickboxing 38 18 40 4 21 29 16

Figure 2.6 A

Lesson 2.6Applying Conditional Formatting
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Class Monday Tuesday Wednesday Thursday Friday Saturday Sunday
Power Yoga 12 23 9 33 21 17 31
CrossFit 8 12 33 19 20 5 16
Spinning 22 27 25 8 14 27 37
Circuit Training 16 9 14 31 34 32 18
Raise the Barre 38 21 27 14 19 9 36
Totally Toned 7 28 22 29 18 14 11
Zumba 10 34 29 22 16 13 32
Kickboxing 38 18 40 4 21 29 16

Power Up Fitness
Class Attendance

Week of August 1st

Figure 2.6 B

Lesson 2.6 Applying Conditional Formatting
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MID:
Use this function to extract one or more content characters 
from the middle out of an existing cell.

CONCAT:
Use this function to extract and combine contents of cells 
or ranges, as well as other characters, into a new cell.

LEFT:
Use this function to extract one or more content characters 
from the left out of an existing cell.

RIGHT:
Use this function to extract one or more content characters 
from the right out of an existing cell.

PROPER:
Use this function to extract and change all characters to 
sentence case from an existing cell.

LOWER:
Use this function to extract and change all characters to 
lower case from an existing cell.

UPPER:
Use this function to extract and change all characters to 
upper case from an existing cell.

Lesson 4.10

Skills
�� Format text by using 
RIGHT(), LEFT(), and 
MID() functions

�� Format text by using 
UPPER() and LOWER() 
functions

�� Format text by using the 
CONCAT() function

�� Format text by using the 
PROPER() function

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Part 4: Working with Numbers and Formulas 

Student Information
Formatting Text with Functions

Lesson Overview
There are many text functions that can assist you in presenting spreadsheet 
data. Microsoft Excel 2019 is equipped with the UPPER, LOWER, and PROPER 
functions, which allow you to change the case of characters. Use RIGHT and 
LEFT to return the leftmost or rightmost characters of a cell. The MID function 
will return any number of characters you specify from any position in a cell. 
Although there are a few different text functions that can combine text, CONCAT 
is especially useful for joining the contents of several cells into one cell. The 
values of cell contents that have been formatted with text functions can then be copied and 
pasted into new worksheets or other programs.

In this lesson, you will use text functions to modify a list of student names and ID numbers.

In order to complete this lesson, access to a lesson resource file is required and should 
be provided by your instructor.
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1.	 Launch Excel 2019 and open the file named Lesson 4.10 SOURCE.

2.	 Save the file as 4.10 Student Information in your My Excel Projects folder on 
your hard drive or network drive.

3.	 Make the following formatting changes:

a.	 Bold row 1.

b.	 Insert a column between Timestamp and Email and key the text [Day 
Entered] as the column heading. 

c.	 Insert two columns between Email and First Name and key the text [Email 
Uppercase] and [Email Lowercase] as the column headings. These now 
become columns D and E.

d.	 Insert three columns between Last Name and Student ID # and key 
the text [Last Name Proper], [Full Name], and [First Initial]. These now 
become columns H, I, and J.

e.	 Key the text [Last 4 Digits of ID] as the column heading in cell L1.

f.	 Fill newly created columns B, D, E, H, I, J, and L with Green, Accent 6, 
Lighter 80%.

g.	 Apply a thick bottom border to cells A1 through L1.

4.	 In cell B2, use the MID function to extract the characters representing the day 
of the month from cell A2.

a.	 Use the following formula: =MID(A2,4,2)

 �Note: This function will take two characters from cell A2 beginning with 
the fourth character.

b.	 Copy the function down for the remaining timestamps.

c.	 Center column B.

5.	 In cell D2, use the UPPER function to copy the contents of cell C2 in all 
uppercase.

a.	 Use the following formula: =UPPER(C2)

b.	 Copy the function down for the remaining email addresses.

6.	 In cell E2, use the LOWER function to copy the contents of cell D2 in all 
lowercase.

a.	 Use the following formula: =LOWER(D2)

b.	 Copy the function down for the remaining email addresses.

Formatting Text with Functions Lesson 4.10

Instructions
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7.	 In cell H2, use the PROPER function to copy the contents of cell G2 in proper 
case.

a.	 Use the following formula: =PROPER(G2)

b.	 Copy the function down for the remaining last names.

8.	 In cell I2, use the CONCAT function to combine the contents of cells F2 and H2 
with a space between first and last name.

a.	 Use the following formula: =CONCAT(F2,“ “,H2)

b.	 Copy the function down for the remaining names.

9.	 In cell J2, use the LEFT function to copy the first character from cell I2.

a.	 Use the following formula: =LEFT(I2,1)

b.	 Copy the function down for the remaining first initials.

c.	 Center column J.

10.	 In cell L2, use the RIGHT function to copy the last four characters from cell K2.

a.	 Use the following formula: =RIGHT(K2,4)

b.	 Copy the function down for the remaining student IDs.

c.	 Center column L.

11.	 Resize the columns to fit cell contents.

12.	 Scale the worksheet to fit one page wide and set row 1 to repeat at the top of 
all pages.

13.	 Select cells A1 through L100 and set the print area.

14.	 Proofread your work for accuracy, then resave the file.

15.	 Print preview. Your worksheet should look similar to Figure 4.10, Pages 1 and 2.

16.	 Print your worksheet if required by your instructor.

Lesson 4.10 Formatting Text with Functions
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